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◊ Welcome to Font Gander Pro

Font Gander Pro is the world's handiest font browser and font specimen printer. It allows you 
to view and print font samples without first installing the fonts. With Drag-and-Drop 
simplicity, you can open and print whole folders or disks full of fonts at one time. It renders 
TrueTypes and Type-1's at high resolution, and works with any printer. The included Gander 
Quill editor - as friendly as any draw program - allows you to design your own layouts 
featuring up to 99 fonts per page. See the accompanying "Getting Started" text file for a 
more detailed introduction to the program.

◊ System Requirements

Font Gander Pro will operate usefully under any version of system software from 7.0 on up, 
on any PowerMac or Macintosh of MacII class or higher. To enjoy its full functionality, you 
should also have Macintosh Drag and Drop installed (introduced as an extension in System 
7.1, and now part of the standard MacOS), and Adobe Type Manager (ATM), version 3.0 or 
higher (freely available at numerous sites, typically bundled with Adobe's Acrobat Reader). 
And of course you should have some font files lying around, uninstalled - the more, the 
merrier. 

◊ Installation

• Place Font Gander Pro in its own folder, so it can find the "Gander Plug-ins" subfolder. Make
one or more aliases of the program for handy access on your desktop, perhaps. This way, 
you can load fonts simply by "drag-and-dropping" them on the Gander icon.
• Launch the program, minimize the main window (Windows menu), and drag the resulting 
mini-window to a convenient place on your screen. This too provides for handy "drop-box" 
access when Gander is running in the background.
• See the "Getting Started" text file for more installation tips.



◊ Loading Fonts

• The easiest way to load fonts is via "drag-and-drop". That is, you simply drag a font file (or 
a folder or diskful of font files) into one of Font Gander Pro's windows. If you have an ancient 
version of System 7, dragging into a window won't work, but you can still drag-and-drop 
fonts onto Font Gander Pro's icon (or an alias of it). The fonts will appear in the upper part of 
the font menu, and the first font in the new batch will be automatically selected for viewing 
(you can tab-key down through the remaining fonts).
• You cannot drag individual fonts from within suitcase files. A font "suitcase" is not the 
same as a folder. Although the Finder allows you to open it like a folder, and you can see 
things that look like individual files inside, it is NOT a folder, and those are NOT independent 
font files until you've moved them out into genuine folders. This is an important distinction, 
because Font Gander Pro only opens true files - i.e., the suitcases themselves, or the inner 
font files AFTER they've resided in a normal folder. It won't hurt if you try to break this rule, 
but it won't do what you want.
• Font Gander Pro does not work with non-installed Multiple Master fonts. Only bitmaps, 
TrueTypes, and Type-1 PostScript (provided you have ATM installed) are presently supported.
• If you have Adobe Type Manager (ATM), and you want to view or print Type-1 PostScript 
fonts at large sizes without 'jaggles', you must keep the high-resolution vector files in the 
same folder where the screen fonts reside. This is the typical way in which all Type-1 font 
utilities operate. When Gander opens a PostScript screen font, it tells ATM where to look for 
the vector version, but it has no way of "knowing" where the vectors are beyond "assuming" 
that they're in the same folder with the screen font.
• You cannot load fonts which are    opened by the system or another utility (they should 
already appear in the lower font menu). Also, to avoid problems, Font Gander Pro refuses to 
load fonts whose names or ID numbers conflict with already-installed fonts.
• Some previous versions of Font Gander would allow you to load the same font several 
times from several different files. In other words, if you opened a 10-point bitmap of 
Garamond, for instance, and then decided it looked too "jaggly", you could simply load a 
Garamond TrueType to sharpen the image. This is no longer possible. In order to load many 
hundreds of fonts without crashing, Gander's internal file-handling routines have gone from 
a simple "open-darn-near-anything" approach to a far more complicated scheme. As a result,
this version may not behave as nicely for people with poorly organized font collections. 
Those users are advised to organize their fonts, and keep all font faces of the same family 
grouped within the same suitcase file, and to prefer suitcase files over other font types. This 
is a good policy to follow whether you're using Font Gander Pro or not.
• To keep members of a non-merged font family together - for example, to keep "L Helvetica 
Light" sorted in with other H's instead of being banished to the L's - go to Preferences and 
check the "Use Family-Based Sorting" box. This applies only to non-installed fonts during 
menu sorting, but it affects how all fonts are queued for print.
• Font Gander Pro can load an entire CD-ROM full of fonts, but if you intend to print them, it 
may be necessary to limit yourself to a few folders full of fonts at a time. (This might be a 
good idea even if you're not printing; it just keeps things more manageable.) Choose "Close 
All Files" from the File menu to purge the fonts you've already loaded, then load the next 
batch of fonts. 
• Non-installed fonts are purged from application memory when you choose "Close All Files" 
or when you quit the program. Font Gander Pro does not modify your system memory in any
way.
• To print fonts without loading them on the Font menu, hold down your option key during 
drag-and-drop loading. Fonts opened in this way will go directly to print, and then will be 
purged from memory.

◊ Browsing Fonts



• In normal "Quick Gander" view, the magnifier simply enlarges the lines of text and allows 
you to slide the view left and right by moving your mouse. It's handy and fun, but there are 
no hidden features that need to be explained (except, perhaps,    that you can use the 
Preferences to customize the sample text and change the magnification).
• In "Full Grid" view, the magnifier displays one character at a time, with its corresponding 
keystroke combination in the lower left (does not work with control characters). If you 
magnify with your shift key down, the keystroke in the lower left will be replaced by the 
character's ASCII number.
• When in Grid View, typing letters on your keyboard will cause the corresponding 
characters in the grid to blink (again, control characters excepted).
• Use the tab key to select the next-lower font on the menu. Shift-tab selects the next-higher
font.
• If you want to compare two fonts widely separated on the menu, switching back and forth 
from one to the other, use the Edit menu's "Undo" command. First select one of the fonts 
manually from the Font menu, then select the other, and after that Undo will toggle between
the two.
• Use the spacebar or option key to temporarily switch from the magnifier to the grabber-
hand (or vise-versa). If you have a programmable trackball or multibutton mouse, set it up 
for option-clicks to avoid manually switching tools altogether.
• Although the expandable main window is subject to shrinking and disappearing offscreen, 
the default settings keep it anchored to your main monitor, so that you can always grab it 
and drag it back into place. If you have multiple monitors and you don't want it anchored, 
you must go to Preferences and uncheck "Pin Main Window to Main Screen". If you do that 
and later the window disappears, use "Fetch Stray Windows" (Windows menu) to bring it 
back to the main screen.
• Click the font name in the toolbar in order to pre-select it for printing (more on printing in 
the next section). Or you can use the Edit menu's "Select for Print" item (Command-S).

◊ Printing Fonts

• When you select "Page Setup / Print..." from the File menu, the program goes into a 
different mode, disabling the functions mentioned so far. You can choose different print 
layouts with the pop-up menu in the lower left. If the "Classic Gander" layout is the only one 
available, you should make sure the "Gander Plug-ins" folder is present with the application 
(see the "Installation" section), and make sure the folder contains plug-in files. Font Gander 
Pro will only load plug-ins at launch time; you cannot add new layouts while the program is 
running. If plug-ins are properly present but they still don't appear in the popup menu, they 
are obsolete or incompatible plug-ins. In that case, you must rebuild the plug-ins with a 
compatible version of Gander Quill (see the "Brief Introduction to Gander Quill" section).
• Some plug-ins may allow you to access their own built-in preferences, to change certain 
options. You can do this by double-clicking on the layout preview. 
• Whichever layout you choose in the print mode menu will become the currently "active" 
layout. Any changes you make in the printer's page setup (click the "Setup" button) or in the
print job dialog boxes will apply to that layout only, and will be saved with that layout.
• When you're not    in print mode, you can print fonts in the current layout without loading 
those fonts on the menu (menu loading can be a slow process with large batches and is not 
necessary for blind printing). To do this, simply hold down your option key during drag-and-
drop operations, or use the "Open..." menu and click the "Print" button instead of the final 
open command. The fonts will go straight to the printer, using the layout you selected 
beforehand, and then those fonts will be purged from memory.
• Under ideal conditions, Font Gander Pro can print an entire CD-ROM full of fonts in one 
pass. In normal practice, however, this can cause low-memory errors and other frustrating 



nuisances. It is better to print only a few folders full of fonts at any one time. Most font 
collections are organized in alphabetic folders, which makes this very convenient.
• If your printer uses "non-square" resolutions, the printout will be limited to the lesser of the
two resolutions. In other words (and in the worst-case scenario), a 300 x 600 dpi printer will 
be reduced to 300 x 300 dpi. Gander supports only "square" resolutions.
• Some users with laser printers may find that their printouts don't show properly reversed 
text -    for instance, white font names won't appear on black bars. This can only be fixed by 
selecting the "Color/Grayscale" option in the print job dialog that belongs to your printer 
driver. You might have to do this whenever you use a new layout for the first time, but the 
setting is saved, so it shouldn't bother you with that particular layout ever again. See your 
printer driver's documentation for more details.
• Users with laser printers should make sure "Bitmap Smoothing" is turned off (as well as 
other smoothing options) in the Page Setup dialog. It does more harm than good, and may 
be responsible for the majority of PostScript errors. Also make sure "Font Substitution" is 
disabled when you're printing installed fonts. See your printer driver's documentation for 
more details.
• There may be other settings which affect output from laser printers. In general, with the 
exceptions just mentioned, default settings are best. Check with your printer's manufacturer.
• Injet printers usually do best with black-and-white settings.
• If problems occur during large print jobs, click on the little printer icon button in the 
Preferences dialog, and reduce the number of "Max. Spool Pages". If problems persist, turn 
off background printing.
• Sometimes many fonts on a layout page can cause extra memory demands on ATM. 
Recent versions of ATM will alert you if there's a problem, but if you have an older version it 
may require some guess-work. You can increase ATM's memory by opening its control panel 
and changing the value in the "cache" field.

◊ A Brief Introduction to Gander Quill

Gander Quill has its own documentation, and a brief tutorial, so we won't say much about it 
here. But    this, in a nutshell, is the whole reason for supplying Font Gander Pro with Gander 
Quill: 
 - You create your own layouts in Gander Quill (or modify existing layout documents, or 
simply open them as-is).
 - You select "Build Plug-in" from Quill's file menu. This turns the layouts into Font Gander Pro
plug-ins.
 - You save or drag the resulting plug-ins into the "Gander Plug-ins" folder, so that Gander 
Pro can find them next time you launch it.

If you don't want to learn anything about Gander Quill, you at least need to know that. Just 
open the Quill layouts, build the plug-ins, and put the plug-ins where Font Gander Pro can 
find them. It's easy as 1 - 2 - 3.

Font Gander plug-ins should be considered 'perishable goods'. We recently changed the file 
format, causing old plug-ins to become obsolete, and we're likely to change it again. But the 
Quill layout documents should last forever. Don't throw your custom Quill layouts away!

◊ Frequently Posed Problems

• How come the font names aren't printing out (or any other white-on-black text)?
 - Laser printers require the "Color/Grayscale" setting for this to work properly. This setting is



accessable through the print job dialog box, not the Page Setup box. You will need to click an
"Options" button or choose from a popup menu. See your printer driver's documentation. 

• How can I keep my "SBI Eurostyle SemiBoldItalic" from ending up so far away from my "B 
Eurostyle Bold"?
 - Go to Preferences (under the Edit menu). Check the "Use Family-Based Sorting" box.

• All the fonts from my CD are jaggly like brick piles. What's "ATM"? 
 - "ATM" is Adobe Type Manager. It's freely available from numerous sources, probably even 
on that CD disc of yours. In order to view or print Type-1 fonts at high resolution, without 
getting "brick piles", you need ATM version 3.0 or higher. You need to install it in your system
as per the instructions that go with it.

• Sometimes my fonts become jaggly unpredictably while I'm browsing them. Sometimes, 
when I'm printing, the first page comes out fine, but then the rest of the pages show jaggles.
 - It sounds like ATM is running low on memory. Open the ~ATM Control Panel and increase 
the number in the Character Cache setting (old versions of ATM call it "Font Cache"). Very 
occasionally, a similar problem can affect TrueType fonts. In that case, you would open your 
Memory Control Panel and increase the Disk Cache setting (older version may call it "RAM 
cache").

• Why am I still getting out-of-memory errors when I print?
 - Several factors can influence this. "Bitmap Smoothing" in the Page Setup dialog could be 
at fault. Turn it off; it's not needed. Or, here again, ATM's cache might be too low (see 
previous entry). Low memory errors can also mean low disk space, since both Font Gander 
Pro and your printer driver create large spool files at print time, and they vie for space with 
virtual memory. So you might need to clean some unneeded files off your drive. It might also
help to reduce Gander's "Max Spool Pages" setting. Access this setting by opening the 
Preferences and clicking the little button with the printer icon. Of course you might need to 
increase Gander's memory allocation. To do that, quit the program, select the program in the
Finder, Get Info on it (under the Finder's File menu), and type higher numbers in the little 
boxes in the lower right of the Get Info window. Sometimes you can go overboard on this, 
causing Gander to use so much memory that there's not enough left for the System, and 
that will cause print-time memory errors, too. Be judicious. Often (VERY often), problems like 
this can be resolved simply by restarting your computer. As a next-to-last resort, restart with
extensions off, to determine if there's something conflicting with normal printer driver or 
disk driver operation. As a very last resort, turn off "Background Printing" in the Chooser.

• How come some of my installed fonts print out in Courier, and some of the others turn into 
who-knows-what?
 - The LaserWriter driver has a Font Substitution setting which often results in Courier 
replacing other fonts. Be sure to disable this setting. Some versions of ATM have a similar 
setting which can result in synthetic fonts. Disable this also.

• Your layouts chop the descenders off my typefaces - the parts that hang down below the 
baseline. Help!
 - Go to the ATM Control Panel and turn on "Preserve Character Shapes".

• The kerning is awful on some of my favorite old fonts. When are you going to offer full 
kerning support?
 - Gander Quill is not a high-end, $1000-dollar, page-layout program, needless to say. The 
plug-ins it produces yield kerning results equivalent to an ordinary word processor. Older 
PostScript fonts can be particularly affected. However, it might help to get the latest ATM, 
and enable its "Precision Character Positioning" option.



• Why are all my printouts 300 dpi? I have a 600 dpi printer!
 - Gander disables "non-square" printer resolutions, and seeks the highest resolution that's 
"square". In all likelihood, you have a 300-by-600 dpi printer, and so 300 is the highest 
Gander can go. There is presently no fix for this problem.

• It does NOT load fonts!    I drag them from the suitcase folders, but nothing happens!
 - Suitcases are not folders. See the second item in the "Loading Fonts" section above.

• Thank you for the floppy disk. Unfortunately, drag-and-drop doesn't work. I'm using 
System 7.0.
 – If you receive Font Gander Pro as a compressed file on a floppy disk, decompress it 
straight to your hard drive. Decompressing the file onto the floppy itself can cause problems 
with icon-based drag-and-drop (the only kind of drag-and-drop available in older versions of 
system software). See the "Getting Started" text file for a full explanation and instructions on
fixing the problem. 

• None of my old plug-ins show up in Gander's popup menu!
 - We recently changed the file format, causing old plug-ins to become obsolete. You will 
have to build new plug-ins from the Gander Quill layout documents. See the Quill 
documentation files, or the very easy "A Brief Introduction to Gander Quill" section above.

◊ The Fine Print

The Font Gander Pro is a full-featured program, but until you pay a one-time licensing fee 
and receive a registration code with which to 'unlock' the program, it puts an 
"UNREGISTERED" watermark on each printed page. The license costs $30 (US) per user, and 
details on purchasing are readily available under the Apple menu -> Product Support. As 
soon as your payment is processed, you will receive a registration code by the best means 
available (email if you provide an email address, fax if that's appropriate, postal mail as a 
last resort). If you purchase through our main sales agent, Kagi, you will first receive a 
temporary code, and we (Semplice) will issue your permanent code soon after. This simply 
allows you to get up and running with the program as soon as possible, even if we're not in 
the office. Your permanent registration code will work in all future 1.x versions of Font 
Gander Pro, so your $30 pays for a whole slew of upgrades.

Font Gander Pro is owned by Semplice Software and is protected by United States copyright 
laws and international copyright treaties. You may not modify, adapt, or translate Font 
Gander Pro without permission from Semplice. You may not reverse engineer, decompile, or 
disassemble Font Gander Pro under any circumstances whatsoever.

Unregistered copies of the Font Gander Pron may be freely distributed for non-commercial 
purposes provided that all ancillary files are included in the package. Commercial 
distributers must obtain written permission from Semplice. Distribution of registered copies 
is strictly prohibited.

Hard copy or digital images originating from Font Gander Pro may not be distributed for 
commercial gain without written permission from Semplice.

Font Gander Pro carries no warranties, expressed or implied. To the best of our knowledge, it 
contains no "bugs" that could harm your computer or cause damage to your files, but we 
cannot guarantee that such a thing will never happen in the extremely complex environment



of a modern computer operating system.

-------------------------------------------------------------------------
"Macintosh", "MacOS", and "LaserWriter" are trademarks of Apple Computer, Inc.
"PostScript", "Acrobat", and "Adobe Type Manager" are trademarks of Adobe Systems, Inc.
The gander's name is "Seymour", but only his mother calls him that.
-------------------------------------------------------------------------


